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1 Automation Engine

1.  Introducing the Browser Client
Working with Automation Engine from within a web browser

In stead of using Automation Engine via the Pilot, you can also do this from your favorite web browser.

Compared to the Pilot, it offers less functionality in a much simpler user interface.

The daily user of browser client uses the configuration that was set up by an administrator user using
the Pilot.

Its functionality is bundled in ‘workspaces’.

Using Workspaces, Downloading apps and some specific Admin tools

A browser client's home page offers these menu items:
 

 

• Workspaces: For daily usage by prepress users. Learn more below.
• Apps & Tools: Come here to download other client apps or other tools.
• Admin: Some very specific admin tools.

Note:  You may notice that most of AE's admin tools are available in the Server Admin pages.
But because those pages are unavailable to SaaS users, we here offer some specific admin
tools that also SaaS users can set from their location.

Workspaces

In the browser client, a workspace is a tailored user interface.

By default, signing in will take you to the generic client workspace called My Workspace.

Depending on your licenses, signing in to the AE browser client may show you more than one
workspace. When you also see the workspace Roll-Fed Labels, this means you also have the licenses
for the product formerly called "Automation Engine QuickStart for Labels".

When you have licenses for more than one client workspace, you can switch to another workspace by
clicking on the icon of Automation Engine in the top bar and then selecting the workspace you want.
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1Automation Engine

 

Workspaces share a user's authentication and his user preferences.

Note:  Technically, these workspaces are different web applications of Automation Engine.
Also notice how, once selected, they have their own URL (page).
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2.  Browsing to your AE server

2.1.  Signing In

Browser Client URL
In a browser, go to http://<AEservername>:9000/

Which browsers are supported is described on www.esko.com/systemrequirements # Automation
Engine  >  Browser Based Client.

Signing In
 

 

About HTTPS

HTTPS is the preferred way to connect. It ensures that all communication is encrypted.

The sign in page will detect if your connection is not secure, i.e. if your network is using HTTP and not
HTTPS. The page will mention this and advise you to switch to using HTTPS. It also refers to this KB
article that explains how this can be done.

Note:  On the AE server computer, go to the Server Config page http://localhost:9897/ #
Browser Client to see or configure the used port and whether HTTP or HTTPS should be used.

Automatic Sign Out

A browser session will automatically sign out
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2Automation Engine

• when the page is open: after 2 hours.
• when the page was closed: after 10 minutes.

2.2.  Can I Use Domain Users?

Yes you can.

You need to set this up on the Automation Engine server using Windows User Management tools.

A domain user can be used when you add it to the Windows users group 'BGusers' or 'BGadmin'.

To see these domain users appear in the browser interface (Admin >  Users), just wait 15 minutes, or
restart the 'bgmd' service.

Note:  Domain users with the same user name as the local user can exist.

2.3.  Can I use the Browser Client from Outside my Network?

• No.

The (browser) client computer must be in the same LAN as the Automation Engine server.

• Yes.

In an AE SaaS setup, the AE server is in a data center, then of course the client can be in a different
network location. The communication then happens via HTTPS.

Learn more in the chapter on AE SaaS.
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3.  Basic features used in every workspace

3.1.  Advanced ways to Search and Filter

There are more advanced ways than those described in the eLearning modules.

Important:  This page assumes that you have seen the modules that illustrate the basic sorting
and filtering in your workspace.

In the eLearning modules, we show that you can type in a value and that you can select a category to
restrict the search to only that category. The selected category is then also added to the text in the
search field. We also show an example where we manually add a combination of categories and values.

Rules and Possibilities when Typing in Filters yourself

We here repeat the main rules and add some extra possibilities and examples.

• In the search field, categories always need to be followed by a ' : '. For example: ' state:run '.

• When the name of a category contains spaces, you must put it in between quotes. For example:
"order material".

• Alternatively, some categories can also be written without spaces. For example: for "due date",
you can also write duedate .

• For "production job name", or "product name", you can even simply write name .

• To have an exact match with the word behind the category, you must place a ' = ' right after the
' : '. For example: "production job name":=blond . This will find the job 'blond' but not the job
'blond_2018'.

• You can type the name of a category in English or in its translated version.
• When the product or job setting contains 'word1' immediately followed by 'word2', you can enter

"word1 word2" or category:"word1 word2" .

• When these 2 words do not appear next to each other or are not even in a same category, you
can enter word1 word2 or category:word1 category:word2. For example: 60 fruitco or name:60
customername:fruitco .

• When the category name is not recognized, it is treated as regular text.
• When you search for a word that ends with a ' : ', put it between quotes to avoid that it is treated as a

category.
• The search field is not case-sensitive.

More Ways to Filter on Date

As shown in the eLearning modules or workspace 'Roll-Fed Labels', you can for example filter on the
creation date of products and on the creation or due date of production jobs. In the workspace 'My
Workspace', you can search a file by its modification date or a Job by its due date, etc.
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• What you enter in the search field must comply with one of these three formats:

• day, month and year
• day, month, year and time in minutes and seconds
• month

• The text of the date also depends on the language that you have chosen in User  > My Preferences.
• Examples of supported dates:

• English:

• 08/28/2017
• 8/28/2017
• "August 28, 2017"
• "Aug 28, 2017"
• "August 28, 2017 4:25 PM"
• "Aug 28, 2017 4:25 PM"
• "Monday, August 28, 2017 4:25 PM"
• "Mon, Aug 28, 2017 4:25 PM"
• August
• Aug

• French:

• 28/08/2017
• 28/8/2017
• "28 août 2017"
• "28 août 2017"
• "28 août 2017 16:46"
• "28 août 2017 16:46"
• "lundi 28 août 2017 16:46"
• "lun. 28 août 2017 16:46"
• août

• German:

• 28.08.2017
• 28.8.2017
• "28. August 2017"
• "28. Aug. 2017"
• "28. August 2017 16:48"
• "28. Aug. 2017 16:48"
• "Montag, 28. August 2017 16:48"
• "Mo., 28. Aug. 2017 16:48"
• August
• Aug.

• All date formats that contain spaces need to be put between quotes.
• Partial date formats are not accepted.
• Entering a date in one of the above formats without specifying a category will also search for the

date in all non-date settings of the product or job (as plain text).
• Next to dates, you can also use the words ' yesterday', 'today' and 'tomorrow'.
• When filtering based on a month, only products or jobs with a creation or due date within that

month of this year will be found.
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• You can combine filtering on dates with filtering on other types of settings.

3.2.  User Preferences and Views

User Preferences
In the top menu bar, click on the name of the signed-in user and choose 'My Preferences'.

• Color Theme (light or dark mode).

The default setting is 'Let browser decide theme'. When this choice is selected, the user interface
of this browser client will be displayed in light mode unless the browser itself has a general setting
regarding its color theme. In that case the workspaces will be in dark mode.

• Example: The browser Safari 12.1 on macOS Mojave (10.14) will, with this setting, appear in the
dark color theme when the macOS is set to 'Appearance Dark' in the system preferences.

• Language: Select the language of the user interface of this browser client.

• Select the preferred unit for these attributes in this browser client: Dimension, Resolution, Ruling,
Weight, Decimals.

• Reset All Dialog Warnings: See this illustrated in the eLearning course about 'My Workspace' in its
module 'Launching Workflows' (section 'Launching in a Job Context', slide 191).

Views
An AE administrator can limit the views that a user gets in his AE client, both in the Pilot and in this
browser client. This is done in the Pilot, in the view Users.

When a View is disabled for a user, then it is not only its name that disappears from the top bar but also
all related functionality. For example when the user does not have the Jobs view, then all file selectors
in other views will also not offer any access to a list of Jobs.

Note:  The names of the Views in the 2 types of AE client are identical, except for the view
Activity, which in the Pilot is named Task.
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4Automation Engine

4.  Workspace 'My Workspace'

4.1.  Concept

Most Functionality for Daily Use, in a Web Browser

In stead of using the Pilot, you can use a browser to connect with the Automation Engine server and get
a simplified client user interface.

This browser client does not offer all functionality that is available in the Pilot.

Its target user is a regular user who can access Jobs and Products data, launch and trace workflows
and manage the to do list.

The Pilot is where an administrator will have created the workflow tickets and have set up all
configuration.

All standard browsers are supported. Find details on www.esko.com/systemrequirements.

You can use the browser client both for an AE On-Premises server as for an AE SaaS server. Learn
about the difference in On-Premises or SaaS.

4.2.  See the eLearning Modules

"My Workspace" is explained with a dedicated course on the Esko Blended Learning platform.

Click here for the eLearning course "Automation Engine – workspace My Workspace”.

This course contains these modules:

• Introduction

• What?
• Access and first views

• Basic Data Management

• Main navigation, filtering and file management within the pages Files, Jobs, Products
• Jobs and Products parameters are shown but are read-only

• Opening Files from a Browser

• How the Esko App Launcher allows you to open files from your browser in a default or selected
local application

• Launching Workflows

• Basic Use
• Public Parameters and how your administrator can make you a custom interface
• Working in and out of a Job context

11
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4 Automation Engine

• Drop File page

• Concept (replacing the standalone application 'Shuttle')
• Basic Use
• Launch Without a File
• Data management & FAQs

• Activity page

• Trace and inspect launched workflows
• Relaunch workflows with same or different files

• To Do page

• Manage or forward to-dos (created by workflows asking your intervention)

4.3.  Jobs page

Important:  Please first see the related eLearning Modules.

Some extra notes:

• The Jobs table is read only.
• It is updated live.
• This view only shows Jobs with a location attribute that the current user is allowed to see. (Jobs

without a location attribute are always shown). Learn more in Locations.

Tip:  Any Smart Views that were created in the Pilot will also show up for this similar page in My
Workspace (browser client).

4.4.  Products page

Important:  Please first see the related eLearning Modules.

Some extra notes:

• The Products view is read only.
• It is updated live.
• This view only shows Products with a location attribute that the current user is allowed to see.

(Products without a location attribute are always shown). Learn more in Locations.

Tip:  Any Smart Views that were created in the Pilot will also show up for this similar page in My
Workspace (browser client).

4.5.  Context Selection tool
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Important:  Please first see the related eLearning Modules.

Some extra notes:

• This button serves to switch between 'Containers' context and a Job context.
• The arrow to its right indicates that all views on its right are affected by the selected context.

4.6.  Drop File page

Important:  Please first see the related eLearning Modules.

Some extra notes:

• The maximum number of drop zones (including the default drop zone) is 64.
• The default drop zone can not be removed or re-arranged.

4.7.  Files page

Important:  Please first see the related eLearning Modules.

Important:  In the Files view, a message pops up when a user tries to open a Job folder or
Product Data Zone for a Job or Product where (s)he is not assigned to the location of that Job/
Product. Learn more in Locations.
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.

4.7.1.  Opening Files from the Browser Client

Concept
For security reasons, web browsers refuse to open files in another local application, at least until you
give your explicit permission. Also in the AE browser client, the first time you request to open a file,
your browser will first ask you if you agree that it opens another application.

Much like in the AE Pilot, you have 2 choices:

• 'Open' is asking to open the file in the application that this client computer uses by default for this
file type. For example: a client computer that by default opens a PDF in Adobe Acrobat.

• To change this behavior, you need to change that file type association setting on that client
computer.

• 'Open With' allows you to choose a (non-default) application (one that was registered?)

'Open'
Browsers show small differences in how they react to this request (below examples were taken on a
Windows10 client).

On each client computer, the first time you select a file and choose 'Open', your browser will react with
this question:

• Google Chrome. Chrome opens this dialog (we blurred out the name of the AE SaaS server):
 

 

• Mozilla Firefox.
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Learn about eskoedit and other technical background on the page about the App Launcher.

Note:  The app on top of the list will be the one taken when you choose 'Open'.

• Microsoft Edge:
 

 

4.8.  Activity page

Important:  Please first see the related eLearning Modules.

The Activity page shows a list of running and recently ran workflows and DeskPack workflows.

Attention:  Note that this page only shows workflows, it does not show single tasks.

Note:  This view only shows workflows that were launched within Jobs or Products with a
location attribute that the current user is allowed to see (workflows that ran in Jobs/Products
without a location attribute are always shown). Learn more in Locations.

Only one entry per workflow is (or DeskPack workflow) is shown ; no workflow steps or individual tasks
are shown. Also workflows started by another workflow are not shown.

Tip:  This page also offers to only show the To-Dos of the current user.
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Tip:  Any Smart Views that were created in the Pilot will also show up for this similar page in My
Workspace (browser client).

4.9.  To Do page

Important:  Please first see the related eLearning Modules.

Tip:  This page also offers to only show the To-Dos of the current user.

Note:  This view only shows to do items that are related to Jobs or Products with a location
attribute that the current user is allowed to see (to do items that relate to Jobs/Products
without a location attribute are always shown). Learn more in Locations.

Tip:  Any Smart Views that were created in the Pilot will also show up for this similar page in My
Workspace (browser client).

4.10.  User page

• My Preferences

• Reset all dialog warnings: Serves to reset your former decision to stop getting requests for
confirmation, as in this example when you switch to a job context:
 

 

• My Account. Info only. Contact your administrator for any changes.

• Sign out: For a manual sign out.

Note:  Your browser session also automatically signs you out when there was no action
noticed for a specific time. In this version, this is set to 10 minutes.

4.11.  Notifications slide-out
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Important:  Please first see the related eLearning Modules.

Some extra notes:

• This slide-out shows recent notifications, new ones on top.
• When a new notification is added, all notifications that are older then half a day are removed.
• Attention:  Notifications are linked to your current browser session:

• They only appear in the browser window or browser tab where you did the action that
triggered the notification (i.e. launch a workflow). When you open another browser client
window/tab, these notifications will not appear in that window/tab.

• They disappear when you refresh your browser.
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5.  Workspace 'Roll-Fed Labels'

5.1.  Concept

Fast and Easy production of Roll-Fed Labels

This workspace will be available when you also have the licenses for the product that was formerly
called "Automation Engine QuickStart for Labels".

Its target user is a prepress operator in a site that produces roll-fed labels (analogue or digital).

Most of the configuration and some of the functionality was prepared by an administrator user using
the Pilot client.

All standard browsers are supported. Find details on www.esko.com/systemrequirements.

You can use the browser client both for an AE on-premises server as for an AE SaaS server. Learn
about the difference in On-Premises or SaaS.

5.2.  See the eLearning Modules

• All eLearning modules serve as initial training and can be accessed from within the browser client.

Find the course on the workspace 'Roll-Fed Labels' on Esko's Blended Learning platform.

• In this chapter, we only add more details, answers FAQs and more.

Note:  The UI of the browser client is available in several languages. Go to <user-name> >  My
Preferences and select one of the listed languages.

5.3.  Post-Install Configuration

Once the Automation Engine server software is installed, the administrator needs to set up some
configuration.

Some configuration steps are done when first signing in to the browser client. Others need to happen
on the DFE.

5.3.1.  Configuration when First Using the Browser Client

The Automation Engine installer creates a shortcut on the desktop. Start the browser client using this
shortcut.
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When starting the browser client the first time on a new system, you will be asked to decide some easy
configuration steps:

1. Create an administrator user

Note:  You will be able to create other users later, via the normal tool in the 'Admin' menu.

When done, login with that user and continue:

2. Configure a data container

A next page invites you to set the data container.

By default a data container called ‘ExampleJobContainer’ is used. This is a shared folder created
during the Automation Engine installation and is located on the same disk as where the Automation
Engine software was installed.

In case you want to use a different shared folder, select this shared folder from the drop-down
list. The default data container can always be changed (via the 'Admin' menu) but already created
products and production jobs will not be moved.

3. A next page asks you to configure presses and their resources. It refers to this documentation. See
the next pages.

5.3.2.  Digital Press Configuration and Migration of Resources

Connecting a Press driven by an Esko DFE (incl. HP L&P Print Server)

Attention:  On this page, "Esko DFE" means a DFE made by Esko, including the "L&P Print
Server" as it is offered by HP Indigo.

An Esko DFE already used color strategies, Dynamic Marks and step & repeat templates. In this
Roll-Fed Labels setup, you need to make sure that these files are now visible and controlled by the
Automation Engine server:

1. Color Strategies

You need to redirect the color strategies on the Esko DFE to the AE server. You then also need to
copy these color strategy files from the DFE to the AE server.

a. On the Esko DFE, redirect the Color resources to Automation Engine

• On the Esko DFE, start up the DFE Configuration tool.
• Go to Start > Programs >  > Esko >  HP SmartStream Print Server  >  HP SmartStream

Configuration.

• Go to the Data tab.

• At the bottom, you will find ‘Resources search path’. Choose ‘Configure'

• Choose ‘On another computer’ and fill in the name of your Automation Engine server.
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• Click OK (2x).
b. Copy Color Strategies from a DFE (Esko DFE or Production Pro) to Automation Engine.

To copy Color Strategies from a DFE to the AE server, proceed as follows:

1. STEP 1

• On the DFE or Production Pro, start Color Engine Pilot 13.4 or higher.

• Go to File >  Preferences >  > Database.

• Location of Color Engine Database : select “On remote computer”.

• Fill in the name of the DFE that you want to copy the color strategies from.

• Click OK.

• It might be required to restart the Color Engine Pilot at this point.

• Now go to the list of Color Strategies (Library >  Color Strategies).

• Select the Color Strategies you would like to copy.

• Once all the Strategies are selected, right-click "Export".

• Make sure the button “archive as one file” is switched on.

• Use the “Browse” button and choose a directory to export the .FP file to.

• Click “Export”.

This results in an .FP file (containing all your Color Strategies) on the selected location.
2. STEP 2

Now import the Color Strategies on the Automation Engine:

• Open the Color Engine Pilot (on the Esko DFE or the HP Production Pro)

• Go to File > Preferences >  Database.

• Location of Color Engine Database: Select “On remote computer”.

• Fill in the name of the Automation Engine server that you want to copy the color
strategies to.

• Click OK.

• Go to File > Import and select the .FP file you created in step 1.

• Click on “Open”. All the exported color strategies are now listed in the “Import” Window.

• Click “Import all” to import the color strategies.
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The selected Color Strategies are now available on both the DFE and Automation Engine
and the Color Strategy Check can be used on these strategies. Learn about this check in the
eLearning course on the workspace "Roll Fed Labels" in the module 'Color Strategy'.

2. Dynamic marks

Any dynamic mark sets present on the DFE must also be made available to the AE server.

Copy the dmk file in the bg_data_marks share on the DFE onto the same share on the AE
server (\\<dfeserver>\bg_data_marks_v010\DynamicMarks to \\<aeserver>
\bg_data_marks_v010\DynamicMarks ).

Note:  These mark sets can contain DFE variables. Learn which of those are supported in
'Can I still use my Dynamic Mark Sets that use Esko DFE variables? on page 29'.

3. SRT templates

SRT templates used by the DFE reside on the share \\<dfeserver>
\bg_data_custom_v010\powerlayout\DFE.

These SRT files have to be imported into the die database of the AE server. This is done by using the
tool in the browser menu Admin >  Dies (one by one).

Note:  In case you have a large number of SRT templates, bulk import of SRT files can be
done using the Pilot interface: copy the SRT files to the ExampleJobContainer of the AE
server and then launch the task "Import Die" on these files. When you don't know the Pilot
interface, ask Esko support for help.

4. Add the DFE press to the AE configuration

In the browser client, add presses via Admin >  Presses. Learn more in the eLearning course on the
workspace "Roll fed labels" in the module on 'Presses'.

Connecting a Press driven by an HP Production Pro

1. Configuration of Color Strategies

The HP Production Pro should be configured to use the color resources from the AE server. This
requires an intervention of an HP service engineer.

In case you already created color strategies on the Production Pro, use the same procedure as
described above to copy strategies from the Production Pro to the AE server.

2. Add the HP Production Pro press to the AE configuration

In the browser client, add presses via Admin >  Presses. Learn more in the eLearning course on the
workspace "Roll fed labels" in the module on 'Presses'.

5.3.3.  Known Limitations
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• In Dynamic Marks, DFE specific fields are not supported

When using DMK sets or SRT templates which contain dynamic marks, the DFE specific text-fields
are not supported in this workspace.

• Non printing inks

When you add non-printing inks to the configuration of this workspace (Admin >  System >  Non-
Printing Inks), you then also need to add these ink names to the list of technical inks on the DFE
(both when Esko DFE and when HP Production Pro). This is especially necessary when you work
with VDP jobs (both when pre-expanded or template based VDP jobs).

5.4.  Details of the Product's Preparation workflow

This page adds some details to the information mentioned in the module 'Product Preparation
Workflow' as part of the eLearning course on the workspace "Roll fed labels".

5.4.1.  Preparation Workflow for Digital Printing

Preflight to Check EPM

This PitStop preflight uses the profile 'HP EPM Basic Check.ppp'.

The product file will not be considered 'EPM ready' when the check finds any of these items:

• Text inside the trim box with a point size of 6 pt or lower.
• Lines inside the trim box with a stroke width of less than 1 pt.
• Filled objects inside the trim box that are smaller than 1 pt.
• Areas inside the media box with a total area coverage (TAC) of CMYK colors equal or higher than

280%.
• black gradients or black images.
• rich black objects (fill or stroke with 100% K and C between 20% and 60%, M between 0% and 60%,

Y between 0% and 60%).

If the input file is a multi-page file (a pre-expanded VDP file), then only the first page is checked.

Preflight to Check Objects

This PitStop preflight uses the profile 'AEQS4L_Basic_Profile.ppp'. This profile is based on the
GWG profiles.

This is what this check does:

• It logs as an error:

• When it finds an empty crop box (GWG 2012 4.04).
• When blending color space is defined and is different from 'Device CMYK' (GWG 2012 4.26).
• When the color space of luminosity soft mask blending is different from 'Device CMYK' or 'Device

Gray' (GWG 2012 4.26).
• When it finds an image (grayscale or color) with a resolution less or equal than 199 ppi (GWG 2012

4.27).
• When it finds a 1-bit image with a resolution less or equal to 549 ppi.
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• When the document is damaged.
• When the document uses any security.
• When the document is empty.
• When there is text inside the trim box that uses any fonts that are not embedded.
• When the document contains annotations of the type 'Movie, sound and 3D', 'TrapNet',

'File Attachment', 'Screen' or 'Watermark'.

• It logs as a warning:

• When checking page rotation flags (GWG 2012 4.05) and it finds a rotation different from 0
degrees.

• When it finds text objects inside the trim box that use the font 'Courier' (GWG 2012 4.15).
• When it finds an image (grayscale or color) with a resolution less or equal than 239 ppi (GWG 2012

4.27).
• When it finds a 1-bit image with a resolution less or equal than 799 ppi (GWG 2012 4.28).
• When the document contains any annotations of the type 'Text note', 'Markup' or

'Hyperlinks'.

The preflight report is saved in the product's 'Data Zone', in a subfolder 'Reports'. Learn more about
these folders in Where is Data Stored? on page 31.

Note:  The system keeps only 1 preflight report. When the prepare workflow is started multiple
times, this report is overwritten each time.

A To-Do to Check the Preflight Report (if needed)

How the workflow continues depends on the result of the preflight:

• No warnings or errors: The workflow sets the product status to Preflight OK and continues the
workflow (if requested, by making the proof).

• Warnings and/or errors: The workflow sets the product status to Preflight Not OK and starts the
step 'Wait for Action (Checkpoint)', which shows up in the browser client as a 'To Do' item.

The user opens the To Do item and reads if the preflight resulted in warnings or errors. He checks
the report and then chooses to click on:

• Preflight OK. The workflow continues. The users decides that this product file is good enough to
produce.

• Preflight NOT OK. The workflow stops here. The user decides that this product file needs to be
changed, that a new PDF is needed.

Proof Report

Learn more about this proof in the page Customizing the Proof Report (used in the ReportMaker (Classic)
task) on page 26.

A To-Do to Check the Proof (if needed)

After the workflow created the proof file (using the step 'ReportMaker'), it (again) starts a 'Wait for
Action (Checkpoint)' step, which shows up in the browser client as a 'To-Do' item.
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• The user can there check the proof file and then choose to click on:

• Proof OK. The workflow continues. The products status is set to 'Proof OK'. This means that the
proof PDF can now be sent to the customer to get their approval.

• Proof NOT OK. The products status is set to 'Proof Not OK' and the workflow stops.

5.4.2.  Preparation Workflow for Flexo Printing

This preparation for flexo does not check for EPM. It does include a step to execute trapping.

Note:  The main workflow principles are described in the page Preparation Workflow for Digital
Printing on page 22. We here mainly illustrate the profiles that are used in the preflight
steps.

Note:  When the public parameter 'Preflight' is set to 'YES', both the preflight steps are done.
Else, none of them is done.

Preflight to check the PDF file's integrity

The end status will be

• Preflight OK when there are no preflight errors (no messages or just warnings)

• Preflight Error when there are preflight errors.

The preflight report is named [file]_PreflightReport.pdf

This PitStop preflight is done using the profile:
'MISINTEGRATION_CheckIncomingPDFIntegrity.ppp' (same profile as used in the standard MIS
integrations).

• This profile logs as an error:

• if the document contains embedded PostScript fragments (error)
• if the document contains pre-separated pages (error)
• if a page is empty (error)
• if there is more than 1 page (error)
• if fonts are not embedded (error)
• if OPI images are used (error)
• if the document contains JavaScript, actions or form fields (error)
• for an empty crop box (GWG 2012 4.04) (error)
• if blending color space is defined and is different from 'Device CMYK' (GWG 2012 4.26) (error)
• if luminosity soft mask blending color space is different from 'Device CMYK' or 'Device Gray' (GWG

2012 4.26) (error)

• This profile logs as a warning:

• if a page scaling factor is set (warning)
• for page rotation flags (GWG 2012 4.05), if rotation is different from 0 degrees (warning)

Preflight to check the printability (Flexo)
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The end status will be

• Prepress Preflight OK when there are no preflight errors (no messages or just warnings)
• Prepress Preflight Error when there are preflight errors.

The preflight report is named [file]_PrintingPreflightReport.pdf

This PitStop preflight is done using the profile:
'MISINTEGRATION_CheckFlexoRequirements.ppp' (same profile as used in the standard MIS
integrations).

• This profile logs as an error:

• when a page is empty (error)
• when there is more than 1 page (error)
• when there are more than the maximum number of separations (public parameter) (error)
• when it finds an empty crop box (GWG 2012 4.04) (error)
• when it finds overprint white text (GWG 2012 4.09) (error)
• when it finds overprint white paths (GWG 2012 4.10) (error)
• when it finds ambiguous spot colors (GWG 2012 4.21) (error)
• when ICC profile versions is higher than 2 (GWG 2012 4.24) (error)
• when classic delivery method (no (calibrated) RGB, ICC, LAB, calibrate gray based colors (GWG

2012 4.25) otherwise logged as error
• when blending color space is defined and is different from 'Device CMYK' (GWG 2012 4.26) (error)
• when luminosity soft mask blending color space is different from 'Device CMYK' or 'Device

Gray' (GWG 2012 4.26) (error)
• when it detects an image (grayscale and color) resolution less or equal than 199 ppi (error). If

resolution is less or equal than 239 ppi (GWG 2012 4.27) (warning)
• when it detects that the resolution of 1bit images is less or equal to 549 ppi (error). If resolution

is less or equal than 799 ppi (GWG 2012 4.28) (warning)
• when it detects single image page images with a resolution less then 450 ppi (error). If resolution

is less than 1200 ppi (GWG 2013 4.29) (warning)
• This profile logs as a warning:

• when it detects page rotation flags (GWG 2012 4.05) with a rotation is different from 0 degrees
(warning)

• when it detects grayscale objects in overprint (GWG 2012 4.08)(warning)
• when it detects overprint 100% black text (GWG 2012 4.11) (warning)
• when it detects ink coverage inside the trim box that is higher than 320% (ignoring objects

smaller than 15mm) (warning)
• when it detects overprint 100% black text defined in deviceGray (GWG 2012 4.12) (warning)
• when it detects overprint thin (stroke width < 2 pt) black lines (GWG 2012 4.13) (warning)
• when it detects overprint thin (stroke width < 2pt) black lines defined in deviceGray (GWG 2102

4.14) (warning)
• when it detects text objects inside the trim box which use the font 'Courier' (GWG 2012 4.15), if

such text objects are found (warning)
• when it detects rich black text (K 85%, TAC 280%) is used (GWG 2012 4.16) (warning)
• when it detects small text (< 5 pt for 1 colorant, < 14 pt for multiple colorants) (GWG 2012 4.17)

(warning)
• when it detects effective line width ( < 0.3 pt for 1 colorant, < 1.5 pt for multiple colorants) (GWG

2012 4.18) (warning)
• checks the spot color naming (GWG 2012 4.20) (warning)
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• when it detects alternate layer configurations (optional content) (GWG 2012 4.30) (warning).

5.5.  Customization

5.5.1.  Customizing the Proof Report (used in the ReportMaker (Classic) task)

The product preparation workflow allows to generate a proofing PDF file. Such a proof file consists of
a preview of the product with some technical information. It also contains a second page showing the
separations.

Note:  The language used in this template is the one you have selected as option in the tab
Prepare of that product.

You can change how that proof file looks by replacing some parts of the proof template file. That
template file is installed during the installation of Automation Engine.

How to change the Proof template

The PDF files for proofing are using a proofing template supplied by Esko (technically: ReportMaker
template). This template PDF refers to 3 separate PDF files that fill different areas of this template.

These external PDF files reside on the folder

\\<Name-of-AE-Server>\ExampleJobContainer\Digital Label Production\Resources\ReportMaker
\Parts

These PDF files correspond to the areas numbered 1, 2 and 3 in the picture below:
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Simply replace each of these separate PDF files with your own content.

• Area 1 consists of ‘Header.pdf’. You could put your own company's logo here for example.

• Area 2 consists of ‘Disclaimer.pdf’. Your company probably has its own specific text that you
want your customers to sign off on.

• Area 3 consists of the PDF file representing the selected roll winding. There are 8 different
windings, represented by 8 PDF files ('Winding_1.pdf' to 'Winding_8.pdf'). You or your
customer might be used to a different style of these icons.

Attention:  When replacing any of these 3 Esko supplied PDF files by your own version, make
sure you respect the dimensions of the original PDF file. Otherwise they will no longer nicely fit
in the default template.

About the default proof template

This template resides on the folder

\\<name-of-AE-server>\ExampleJobContainer\Digital Label Production\Resources\ReportMaker\

This template should not be changed as it gets replaced by the default template that comes with an
Automation Engine installation after each update.

If a different template is required, skilled users or Esko staff can create one using Esko PackEdge but
it should be given a different name. They will also need to use the Automation Engine Pilot to create a
customized version of the 'prepare' workflow, so that it refers to that new template.
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Units and Language

The unit used in the dimensions (artwork info & dimension lines) and the language of the report are
those as set in the Product's Settings > Tab 'Prepare' > Proof.

The proof template has all the language specific texts present in dedicated layers (1 per language). The
chosen language decides which layer is kept (during the workflow step "Optimize PDF document").

5.5.2.  Customizing Workflows

Customizing a Product's Preparation Workflow

In the 'Prepare' tab you can save variants of the workflows that are offered by default.

When you want to customise a workflow further than that, this then needs to be done by Esko staff, as
a paid service.

For any such request, please contact Esko Solution Services.

Customizing a Production Job's Output Workflow

The production job types that have no live connection to a digital press, end in sending files to another
component.

In their tab 'Output' you select the matching 'output' workflow, which is by default a simple copy of
those files. And you there also specify their destination.

When you want to customise that output workflow, for example to have those PDF files also RIP'ed and
submitted to a DFS of an Esko CDI, then this also needs to be done by Esko staff, as a paid service.

For any such request, please contact Esko Solution Services.

Note:  You may have purchased those services already together with the set up of this Roll-Fed
Labels solution. Then this customisation may be done soon after the initial installation.

Note:  Output workflows that you created using the Pilot client, need a special tag to make
them appear in this workspace:

• For the type 'Digital to PDF', the tag needs to contain QuickStart Digital Output.

• For the type 'Flexo to PDF', the tag needs to contain QuickStart Flexo Output.

5.6.  Frequently Asked Questions

5.6.1.  Which File Formats can I use for a Product?

You can create a Product (part) from these file formats:

• *.PDF
• *.AI Adobe Illustrator when PDF compatible
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Attention:  When you use the Esko plug-in 'Borders' to set the PDF Trim Box / Media Box
in Adobe Illustrator, Automation Engine will ignore these settings. To make sure that these
Trim Boxes / Media Boxes will be used, you need to export the file to 'Normalized PDF'.

• Esko Normalized PDF when self-contained (no external images or other files).

5.6.2.  What about Multi-page Files?

Can I use Multi-page Files?

When you use a multi-page PDF to make a product, the system automatically assumes that this file is
for a VDP workflow and so decides that this product is a VDP product. A pop-up message informs you
about this.

This means that, apart from that VDP case, you can not use multi-page PDFs to make products.

Note:  In the Viewer, you can compare different pages of a multi-page file. Learn about
comparing in this Viewer tool by checking the WebCenter Online Help (Complete Manual >
WebCenter Viewers > HTML5 Viewer > Compare Documents.

5.6.3.  Can I Print a Product that is 'Not Ready For Production'?

Yes you can.

As explained in the eLearning module about Product Status, a product will be 'Ready for Production'
when it has its file been 'Approved'.

This product status is only information. You can still produce it. But when starting a production job that
includes this product, you will be asked if you are sure if you want to print it.

5.6.4.  Can I still use my Dynamic Mark Sets that use Esko DFE variables?

Summary

A dynamic mark set can contain dynamic text marks that refer to variables on the Esko DFE.

When launched from this workspace 'Roll-Fed Labels', where they added to the S&R task in the
production workflow, most of the DFE variables (press name, printing inks, color strategy...) are
supported, with the exception of these:

• 'Screen name' is not supported. AE has no access to screening info.

• 'Substrate name, Printing Ink Names (long and short) and Color Strategy Name' are only supported
in case the Press Material or Color Strategy are explicitly selected in the UI of this workspace (not
when only chosen as 'from Press Ticket').

• 'Step and repeat template name' is only supported with template dies, in which case it will
represent the name of the SRT file it was based on.
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Table of DFE variables supported in a Dynamic Mark set selected in the workspace
'Roll-Fed Labels'

CategoryField Info

DocumentFile name Comma separated list of the URLs of the input graphics. URLs can
contain hex-encoded (%XY) characters.

File date Modification date of the input graphic(s).

File time Modification time of the input graphic(s).

File date and
time

Modification date & time of the input graphic(s).

File Trim Box Trim Box of the input graphic(s).

File Media Box Media Box of the input graphic(s).

Color Input ink names List of ink definitions of the input graphics.

Input ink names
(short)

List of ink short definitions of the input graphics.

Printing ink
names

List of names of the printing inks (ink set + extra output inks). Only works
if color strategy was selected in the workspace 'Roll-Fed Labels' (not
from the press ticket).

Printing ink
names (short)

List of names of the printing inks. Only works if color strategy was
selected in the workspace 'Roll-Fed Labels' (not from the press ticket).

Color strategy
name

Only works if the color strategy was selected in the workspace 'Roll-Fed
Labels' (not from the press ticket).

Print
Job

Print job name Name of the production job in the workspace 'Roll-Fed Labels'.

Print job date Generated by the S&R task (current date/time).

Print job time Generated by the S&R task (current date/time).

Print job date and
time

Generated by the S&R task (current date/time).

Press name Name of the selected press.

Substrate name Only works if the press medium was selected in workspace 'Roll-Fed
Labels' (not from the press ticket).

Job comment Typically a message for the press operator.

SRT template
name

The name of the SRT template or the name of the numeric die. The S&R
task already has this parameter in its ticket.

5.6.5.  VDP Block Distribution = Fill over Rolls

In an Esko DFE, I can use 'Block Distribution'. Where can I do that in this workspace?

Users of an Esko DFE, when working with VDP jobs, can use a method of distributing the variations
called 'Block Distribution'.
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Here, in the workspace 'Roll-Fed labels', this function is named 'Fill over Rolls'.
 

 

Note:  In this workspace 'Roll-Fed Labels', the term 'blocks' is used for other (non-digital) use
cases.

Learn more in one of the eLearning modules on Variable Data Printing.

In the eLearning module 'VDP - VDT file and Counter', rolls are defined in the tab 'Production Settings'
and distribution of the variants (flow and fill) is defined in the tab 'Printing Sequence'.

Of course, this function is valid for all 3 types of VDP Products.

5.6.6.  Can I Change the Proof Template?

Yes, you can.

This is described in the page Customizing the Proof Report (used in the ReportMaker (Classic) task) on
page 26.

5.6.7.  Where is Data Stored?

This workspace offers all the tools to access and view the relevant production data. The extra
information on this page is therefore for users that need a more advanced knowledge of where this
product and job data is stored. These are typically Esko staff or users who were already familiar with
the 'Pilot' client interface.

Where is the Data of a Product stored?
• The files that you upload to create a product are stored on the Automation Engine server, decided

by a rule-based logic called the Smart Product Location.

Note:  For those that know the 'Pilot' client, this setup can be found at Pilot >  Configure > 
Products >  Smart Product Location.
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• When no rules were configured in that tool, the product files are stored in the
'ExampleJobContainer'. This is a shared folder on the Automation Engine server that was created
automatically when Automation Engine was installed.

Product files are then stored according this file path:

\ExampleJobContainer\Products\<ProductCustomerID>\<ProductName>

This folder structure is created automatically when you upload a PDF file for that product (for the
first time).

Note:  If, for some reason, the folder 'ExampleJobContainer' does not exist, the files will be
stored in a randomly chosen shared folder (= 'Container'), following that same file path:

\<OtherSharedFolder>\Products\<ProductCustomerID>\<ProductName>

Note:  New products that were saved but for which no file was uploaded yet will not show a
product folder.

• This folder <ProductName> contains the PDF that you upload for this product. When you upload
other file(s) later on, they are also put there. Files with a same name will be overwritten.

Subfolders are created automatically for each type of data:

• \Proofs: The proof PDF file is located here. When a preparation workflow is run more than once,
proof files will be overwritten.

• \Reports: The Preflight report PDF is located here. When a preparation workflow is run more
than once, preflight report files will also be overwritten.

• \Uploads: Product files for which a preparation workflow was started are copied here. To make
sure they are not overwritten, a prefix is added to their name with the date and time you started
the workflow.

Note:  The files in these 3 subfolders are visualized in the tab 'Data' of a product's settings.
The data categories match these folder names.

Note:  This product folder and its subfolders are also referred to as the Product Data Zone.

Attention:  When you use the browser workspace to remove a product, users of the Pilot client
will notice that its complete Product Data Zone is deleted! A clear warning does appear and
asks you to confirm before this data is deleted from the Container.

Where is the Data of a Production Job stored?

The data related to a production job is stored according the same logic as described above for
products.

The moment a job is saved for the first time, a folder is created under

\ExampleJobContainer\Jobs\<ProductionJobName> 

(unless otherwise configured in the tool 'Smart Job Location').
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Users of the Pilot client can see this folder as a blue 'Job'. The production workflow runs in this job
context.

All data created during the production workflow is stored in this folder, in a subfolder \temp. Such
'temp' folders are hidden in the Pilot client, but they will be visualized when for example, on one of the
tasks in the workflow, you ask to 'Go to Output File'.

This folder contains:

• the Step & Repeat PDFs. One for each form of layout (<jobname>_sr_1.pdf etc..)

• the JDF file to communicate with the DFE (printrun_***.jdf)

• XML files describing the product PDFs (location, technical inks to ignore)

• PDF of each station (product PDF or empty station version of that product).

When you use the browser workspace to remove a production job, users of the Pilot client will see that
the job is removed from the list of active jobs but that all its data are still kept (the blue folder becomes
yellow but all its data on disk remains).

Where are the Dies stored?

In this workspace, you can create a new die by importing a template step & repeat file (.SRT or .PDF).
Learn more in eLearning module 'Dies' as part of the course on Roll fed Labels.

The system reads this file, adds the resulting die to its database and uploads the imported file to the AE
server on:

\Esko\BG_DATA_CUSTOM_V010\powerlayout\ae

5.6.8.  Can I Remove an Order Material that is in Use in a Job?

When you remove an order material, products that used that order material will from then on have this
setting on <none>.

The same thing happens for production jobs: this setting (which it gets from its products) also changes
to <none>. This is not a real problem as you can still start its production workflow.

Note:  Mind that the material that needs to be communicated to the DFE is not the order
material but the press material. The order material is currently only used as a filter when
adding products to a job.

Follow these steps to get a different order material in a production job:

1. Update the products of that production job with another order material.
2. In the production job:

a. first remove those product(s),
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b. then (re-)add the updated product(s) (and re-set the quantity and printing sequence).

5.6.9.  What happens when I make Changes to a Product that is Used in a
Production Job?

Can I change attributes of a Product that is used a Production Job?

Yes you can. However, the moment a product is added to a production job, its settings like customer ID
and order material are copied into that job. These values are not just references.

Important:  This means that changing the order material and/or customer of a product after
the product has been added to a production job does not update the value of the order material
and/or the customer of a production job.

What happens if I Rename a Product After it was already Added to a Production Job?

Renaming a product while it was added to one or more production jobs is not a problem. The jobs can
be produced successfully. The job uses an internal ID reference to its products. It will pick the products
it was intended to use.

Attention:  When a print mark is asked to put the product name on the layout PDF, this could
be the old product's name (depending on the time the changes are made).
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6.  ADMIN page

 

 

This page serves to

• define if you want to have a usage dashboard.

• manage tokens for external systems that wish to communicate with AE via HTTPS (AE SaaS only).

Learn more in the chapter Automation Engine Server Management , in the section The AE Browser Client
ADMIN page.
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